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EinfGhrung

Mit AutoCAD LT®, der weltweit filhrenden Software fiir die Erstellung von Zeichnungen und Detaildarstellungen
in 2D, kénnen Sie lhre Produktivitat steigern und Ihre Routinearbeiten beschleunigen. AutoCAD LT ist eine
leistungsfahige Lésung fir Konstrukteure, die eine vollstandige Kompatibilitat zum DWG ™-Dateiformat
bendtigen, ohne 3D-Fahigkeiten oder erweiterte Anpassungsmaéglichkeiten zu brauchen. Verbessern Sie lhre
Effizienz dank einer neuen Benutzeroberflache, die nicht nur Routineaufgaben beschleunigt, sondern in der
Befehle auch einfacher zu finden sind. So kdnnen Neueinsteiger rasch produktiv arbeiten. Die Arbeit mit Layern
ist jetzt noch einfacher denn je. Erleben Sie eine neue Dimension der Produktivitéat mit AutoCAD LT.

Benutzeroberflache

Die Benutzeroberflache von AutoCAD LT 2009 wurde Uberarbeitet und intuitiver gestaltet. Neben einfachem
Zugriff auf die am haufigsten benutzten Werkzeuge verfiigen Sie jetzt auch tber einen vergrof3erten
Zeichnungsbereich. In der Standard-Benutzeroberflache finden Sie den Meni-Browser, den Schnellzugriffs-
Werkzeugkasten, das InfoCenter, die Multifunktionsleiste und die Statusleiste. Am besten lassen sich die
verschiedenen Erweiterungen der Benutzeroberflache mit einer Dual-Monitor-Konfiguration nutzen.

Die Hintergrundfarbe des Modellbereichs wurde in einen Cremeton geéndert, sodass Sie bei lhrer
Zeichnungserstellung im Modellbereich auch dunkle Farben verwenden kdnnen, die im weif3en Papierbereichs-
Layout ebenso einfach zu sehen sind.
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Abbildung 1. Die benutzeroberflache von AutoCAD LT 2009
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Menu-Browser

Der neue Meni-Browser bietet Uber eine grol3e Schaltflache in der linken oberen Ecke des AutoCAD-Fensters
einfachen Zugriff auf verschiedenste Inhalte, einschlief3lich Befehle und Dokumente.

Abbildung 2. Meni-Browser-Schaltflache

Die bisher horizontal oben im AutoCAD-LT-Fenster angeordneten Menis werden im Men{-Browser nun in
einer vertikalen Listenansicht dargestellt. Durch die Auswahl eines Menis auf der Liste wird diese erweitert,
sodass Sie bequem den gewlinschten Befehl aufrufen kénnen.
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Abbildung 3. Menu-Browser

Uber das Suchwerkzeug oben im Menii-Browser kénnen Sie die CUI-Datei nach Schliisselbegriffen
durchsuchen. Geben Sie beispielsweise L-I-N-I-E im Suchfeld ein, durchlauft die Suchfunktion dynamisch die
Suchoptionen, um samtliche CUI-Eintrdge anzuzeigen, die das Wort Linie enthalten (also etwa Linientyp, Linie,
Multilinie, Schnittlinie etc.). Anschlieend kénnen Sie per Klick den zugehdrigen Befehl aufrufen.

www.autodesk.de/autocadlt Vertraulich — Unterliegt einer Geheimhaltungsvereinbarung




AUTOCAD LT 2009 — VORSCHAU UND EINFUHRUNG

Matches for: "LINE"

Best Matches |
/ Line Draw > Line 1
Edit
</ Undo Lins Edit > Uindo Line
Wiew i
1% Color Hidden Line Wiew > Shade > 16 Color Hidde...
Format
Linetype... Format > Linsfype...

Linsweight... Format > Lineweight...

Abbildung 4. Das Suchwerkzeug des MenU-Browsers

Neben dem Zugriff auf Befehle erméglicht Ihnen der Meni-Browser auch die Anzeige und das Offnen der
zuletzt verwendeten oder gedffneten Dokumente. Zusétzlich zu den Namen der Dokumente kénnen Symbole
oder kleine, mittelgrof3e und groRRe Voransichten angezeigt werden, sodass Sie lhre gewilinschte Datei rasch
auffinden.
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Abbildung 5. Voransichten fiir Dokumente im Menl-Browser
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Der Meni-Browser zeigt lhnen die zuletzt genutzten Dokumente wahlweise der Reihenfolge nach in einer Liste
oder nach Datum bzw. Dateityp gruppiert an. Sobald Sie mit dem Mauszeiger Uber den Namen eines
Dokuments fahren, werden eine Vorschau des Dokuments sowie weitere dokumentspezifische Informationen
angezeigt.
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Abbildung 6. Vorschau der zuletzt genutzten Dokumente

Neben den zuletzt genutzten Dokumenten kénnen Sie Uber den Meni-Browser einfach auf die zuletzt
ausgefiihrten Aktionen zugreifen. Wahlen Sie einfach aus der Liste der letzten Aktionen eine aus, die
wiederholt werden soll.

Weitere Funktionalitat bieten die Kontextmenis des Menl-Browsers. Hier kdnnen Sie u. a. ein Dokument oder
eine Aktion fixieren, damit diese bei Hinzukommen weiterer Dokumente oder Aktionen nicht aus der Liste fallen,
oder die Listen der zuletzt verwendeten Dokumente bzw. Aktionen l6schen.
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Abbildung 7. Optionen des Kontextmenls im Meniu-Browser

Schnellzugriffs-Werkzeugkasten

Der Schnellzugriffs-Werkzeugkasten befindet sich oben im AutoCAD-LT-Fenster neben dem Menu-Browser. Er
enthalt die am haufigsten genutzten AutoCAD-Befehle, wie z. B. Neu, Offnen, Sichern, Plotten, Widerrufen
(ZURUCK) und Wiederherstellen (ZLOSCH). Im Dialogfeld ,Benutzeroberflache anpassen®, das tiber das
Kontextmeni aufgerufen werden kann, lassen sich weitere Werkzeuge hinzufiigen oder vorhandene aus der
Aufstellung entfernen. Ziehen Sie mit der Maus Befehle aus der Befehlsliste auf den Schnellzugriffs-
Werkzeugkasten. Die im Schnellzugriffs-Werkzeugkasten angezeigten Befehle werden jeweils fur den
entsprechenden Arbeitsbereich gespeichert und kénnen problemlos umgeordnet oder entfernt werden. Neben
der Option Anpassen des Schnellzugriffs-Werkzeugkastens kénnen Sie Uber das Kontextmenu die Anzeige von
Menlleiste und Werkzeugkésten steuern.

Cusktomize Quick Access Toolbar, .,
Show Menu Bar

/ J"‘v L0 Toolbars L

Abbildung 8. Schnellzugriffs-Werkzeugkasten

InfoCenter

Das InfoCenter in AutoCAD LT 2009 wurde optimiert, um Sie bei der Suche nach Hilfe noch flexibler zu
unterstiitzen. Sie kénnen das Suchfeld aus- oder einklappen, und so Platz in der Titelleiste sparen. Aul3erdem
konnen Sie jetzt, wenn Sie das AutoCAD-Hilfesystem nach einem Thema durchsuchen, angeben, welches
Dokument durchsucht werden soll, was Ihre Suche erheblich beschleunigt.
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Abbildung 9. InfoCenter

Multifunktionsleiste

Die Multifunktionsleiste, die oben im AutoCAD-LT-Fenster zu finden ist, bietet Uber Registerkarten und Gruppen
einfachen Zugriff auf die Werkzeuge von AutoCAD LT. Jede Registerkarte umfasst mehrere Gruppen, von
denen wiederum jede mehrere Werkzeuge enthalt. Manche Gruppen lassen sich erweitern und bieten so
Zugriff auf zusatzliche Werkzeuge.
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Abbildung 10. Multifunktionsleiste

Standardgeman ist die Multifunktionsleiste oben im AutoCAD-LT-Fenster verankert, Sie kénnen jedoch sowohl
ihre Anzeige als auch ihr Verhalten tiber das Kontextmeni steuern. Wenn Sie die Multifunktionsleiste
geschlossen haben, kénnen Sie sie mit dem Befehl Multifunktionsleiste jederzeit wieder aufrufen. Deaktivieren
Sie die Option zur Anzeige von Gruppentiteln, oder minimieren Sie die Registerkarten bzw. Gruppentitel, um
die GesamtgroRRe der Multifunktionsleiste zu reduzieren.
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Abbildung 11. Kontextmenu fur die Multifunktionsleiste

Ahnlich wie der Befehls-Navigator lasst sich auch die Fixierung der Multifunktionsleiste aufheben, um sie links
oder rechts im Fenster neu zu verankern.
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Abbildung 12. Titelleisten-Kontextmenu der Multifunktionsleiste

Die Anzeige der Inhalte in den Registerkarten und Gruppen der Multifunktionsleiste kénnen Sie selbst steuern.
Dazu brauchen Sie nur mit einem Klick der rechten Maustaste das Kontextmenu zu 6ffnen, wo Sie
Registerkarten und Gruppen aktivieren oder deaktivieren kdnnen. Per Drag&Drop lassen sich Registerkarten
oder Gruppen innerhalb der Registerkarten an eine neue Position ziehen. Sie kénnen sogar Gruppen aus der
Multifunktionsleiste herausziehen, um separate, verschiebbare Gruppen zu erstellen. Fir eine individuelle
Anpassung der Multifunktionsleiste kdnnen Sie die neuen Multifunktionsleisten-Knoten im Dialogfeld
.Benutzeroberflache anpassen” nutzen.
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Abbildung 13. Kontextmenu fur Multifunktionsleisten-Inhalte

Statusleiste

Die Statusleiste von AutoCAD LT wurde um neue Werkzeuge und Symbole erweitert. Links auf der Statusleiste
finden Sie jetzt Schalter fur gangige Funktionen, wie etwa Ofang, Raster und Dynamische Eingabe. Uber das
Kontextmeni kénnen Sie einfach festlegen, ob auf der Statusleiste Symbole oder klassischer Text angezeigt
werden sollen. Der Schnelleigenschaften-Schalter ist ebenfalls neu hinzugekommen.
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Abbildung 14. Schalter der Statusleiste

Die Kontextmenis fur einige Schalter auf der Statusleiste weisen zusétzliche Optionen fir den Schalter auf.
Dank des einfachen Zugriffs auf diese Optionen ersparen Sie sich den Umweg tiber das Dialogfeld
+Einstellungen®.
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Abbildung 15. Kontextmenus der Befehle Fang, Polar und Ofang

Die Schaltflachen ,Modell“ und ,Layout” befinden sich nun im rechten Teil der Statusleiste neben einigen
weiteren, neu hinzugekommenen Werkzeugen. Das Layout-Flyout wurde durch die Schaltflache der
Schnellansicht fur Layouts ersetzt, neben der sich die Schaltflache der Schnellansicht fur Zeichnungen
befindet. Die Statusleiste bietet einfachen Zugriff auf Werkzeuge zur Navigation und Anzeige, darunter Pan und
Zoom sowie die neue SteeringWheels™-Funktionalitat. Der Beschriftungsmaf3stabsschalter wurde durch einen
Schalter zum Wechseln zwischen Ansichtsfenster und Beschriftung ersetzt. Damit ist der
BeschriftungsmalRstab mit dem Ansichtsfenstermalf3stab verkniupft, sodass beide stets synchron sind. Die
ebenfalls neue Schaltflache ,Arbeitsbereichswechsel” tritt an die Stelle des Arbeitsbereiche-Werkzeugkastens.
Sie bietet die gleiche Funktionalitat, bendtigt aber weniger Platz.
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Abbildung 16. Werkzeuge der Statusleiste
Schnelleigenschaften

Die Schnelleigenschaften-Leiste ermoglicht es Ihnen, Objekteigenschaften nach Bedarf anzuzeigen und zu
bearbeiten, ohne zuviel Platz in Anspruch zu nehmen. Uber den entsprechenden Schalter auf der Statusleiste
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koénnen Sie die Schnelleigenschaften aktivieren. Wenn diese aktiviert sind, wird im Schnelleigenschaften-
Fenster automatisch eine editierbare Liste von Eigenschaften angezeigt, wenn Sie ein Objekt auswéhlen. Ist
die Liste der Objekteigenschaften langer als das Schnelleigenschaften-Fenster, wird dieses automatisch
erweitert, sobald sich der Mauszeiger dariiber befindet.
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Abbildung 17. Das Fenster , Schnelleigenschaften®

Uber ein Kontextmenii konnen Sie das Verhalten und die Darstellung des Schnelleigenschaften-Fensters
steuern. Ist die Option zum automatischen Ausblenden des Fensters deaktiviert, behalt es seine volle GréRRe
bei. Die Option fur die Positionierung des Fensters ermdglicht es Ihnen, festzulegen, wo das
Schnelleigenschaften-Fenster angezeigt werden soll. Entscheiden Sie sich fir den Cursor-Modus, wird die
Fensteranzeige in Relation zu Ihrer Cursor-Position gesetzt. Wahlweise kénnen Sie das Schnelleigenschaften-
Fenster auch als verschiebbares Fenster anzeigen lassen oder als Gruppe auf der Multifunktionsleiste fixieren.
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Abbildung 18. Optionen zur Positionierung des Schnelleigenschaften-Fensters

Das Dialogfeld fur Zeichnungseinstellungen verfligt jetzt Uber eine neue Registerkarte fur Schnelleigenschaften,
wo Sie weitere Einstellungen fiir das Schnelleigenschaften-Fenster vornehmen kénnen. Auf dieser
Registerkarte kdnnen Sie die Schnelleigenschaften aktivieren und deaktivieren und festlegen, ob das
Schnelleigenschaften-Fenster bei jeder Objektauswahl oder nur bei der Auswahl von Objekten mit definierten
Schnelleigenschaften gedéffnet werden soll. Diese Option stellt damit eine Alternative zur Wahl des
Positionsmodus dar und erméglicht Ihnen die Vorgabe von Richtung und Abstand des Fensters in Bezug auf
den Cursor bei aktiviertem Cursor-Modus. Und schlief3lich kénnen Sie auf der Schnelleigenschaften-
Registerkarte die Anzahl der Zeilen festlegen, die im reduzierten Schnelleigenschaften-Fenster standardmafig
sichtbar sind.
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Abbildung 19. Die Registerkarte ,, Schnelleigenschaften” des Dialogfelds flr
Zeichnungseinstellungen

Sind mehrere Objekte ausgewahlt, verhalt sich das Schnelleigenschaften-Fenster ahnlich dem bekannten
Eigenschaften-Fenster und zeigt nur diejenigen Eigenschaften an, die alle ausgewahlten Objekte aufweisen.
Aus einer Drop-Down-Liste kdnnen Sie ein Objekt auswéahlen, um alle Schnelleigenschaften dieser speziellen
Objektart anzuzeigen.
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Abbildung 20. Schnelleigenschaften-Fenster mit mehreren ausgewahlten Objektarten

Im Dialogfeld ,Benutzeroberflache anpassen” haben Sie die Mdglichkeit, festzulegen, welche Eigenschaften fur
die einzelnen Objekttypen angezeigt werden sollen. Das Dialogfeld rufen Sie einfach tber die Option
+LAnpassen” in der rechten oberen Ecke des Schnelleigenschaften-Fensters auf. Das Dialogfeld wird angezeigt,
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und der Schnelleigenschaften-Knoten ist bereits ausgewahlt. Im rechten Teil des Dialogfelds

.Benutzeroberflache anpassen” werden zwei Listen angezeigt: die definierten Objektarten und die verfugbaren

Objekteigenschaften fir eine festgelegte Objektart.
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Abbildung 21. Definition von Schnelleigenschaften

Sie kdnnen Elemente zur Objektarten-Liste hinzufiigen oder entfernen. Dazu verwenden Sie die Schaltflache
+Objektart bearbeiten* am oberen Rand der Liste.

&, Edit Object Type List
[ Body H
[#]circle
[1oGN underlzy
Diarnetric Dimension
[ owF underay
[ENips=
[ ]External Reference
[]Flip Action
[ Flip Grip
[ ]Fip Parameter
Hatch
[ Helix
[¥]1ogged Dimension
Leader

Abbildung 22. Bearbeitung der Objektarten-Liste

Schnellansicht fir Layouts

Die Schaltflache fir Layout-Schnellansichten auf der Statusleiste zeigt eine Reihe von Schnellansichts-Bildern
von Layouts. Diese neue Funktionalitat bietet eine schnellere und visuellere Alternative zur Verwendung der
klassischen Registerkarten ,Modell“ und ,Layout“, um zwischen mehreren Layouts innerhalb der aktuellen
Zeichnung zu wechseln. Hier kbnnen Sie Layouts erkennen und auswahlen, und zwar nicht nur dem Namen
nach, sondern anhand ihres Aussehens. Bewegen Sie den Mauszeiger tber den Fensterrand hinaus, um
Layouts anzuzeigen, die sich dahinter verbergen. Die Gré3e der Layout-Voransichten kénnen Sie regeln,
indem Sie die Strg-Taste gedruckt halten und dabei das Scroll-Rad Ihrer Maus vor oder zurlick drehen.
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Abbildung 23. Bilder der Layout-Schnellansicht

Bewegen Sie den Cursor uber eine Layout-Vorschau, so werden in den oberen Ecken des Bildes Schaltflachen
fur das Plotten und Publizieren angezeigt. Weitere Werkzeuge stehen in der Schnellansicht-Steuerungsleiste
zur Verfiigung, die automatisch unterhalb der Schnellansichts-Bilder angezeigt wird. Mit diesen Werkzeugen
konnen Sie die Schnellansicht fixieren, wenn sie wahrend lhrer Arbeit im Zeichnungs-Editor getffnet bleiben
soll. Wird die Schnellansicht nicht mehr benétigt, lasst sie sich einfach mit dem ,SchlieRen“-Befehl beenden.
Die Schaltflache zur Erstellung eines neuen Layouts legt ein neues Layout innerhalb der aktuellen Zeichnung
an; das dazugehdorige Vorschaubild wird am Ende der Schnellansicht-Vorschaureihe hinzugefiigt. Das
Publizieren-Werkzeug erméglicht Ihnen das Publizieren aller Layouts einer Zeichnung.

P[— Publizieren
ﬂ Plot

1 — | ayout-Schnellansicht fixieren

= {— Neue Layouts

Publizieren
Layout-Schnellansicht schlieBen

Abbildung 24. Die Steuerungsleiste der Layout-Schnellansicht
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Durch einen Klick mit der rechten Maustaste auf eine Layout-Vorschau zeigen Sie die vertrauten Optionen des
Layout-Mends an, Uber das Sie auch den Seiteneinrichtungs-Manager aufrufen kdnnen. Eine neue Option im
Kontextment ermdglicht Thnen den Export der Layout-Geometrie in den Modellbereich einer neuen Zeichnung.

= Mew layaut

' From template...
Delete

Fename

Mowe or Copy...
Select All Layouts

Activate Model Tab

F Page Setup Manager...
Plat...

—i Export Layout 1o Model. .

Abbildung 25. Das Kontextmenu der Layout-Schnellansicht

Schnellansicht fir Zeichnungen

Die Schaltflache fir die Zeichnungs-Schnellansicht auf der Statusleiste zeigt eine Reihe von Vorschaubildern
von Zeichnungen. Diese neue Funktionalitat bietet eine raschere, visuelle Alternative zur Tastenkombination
Strg+Alt oder dem Fenster-Menu, wenn Sie zwischen getffneten Zeichnungen wechseln mochten. Wie bei der
Layout-Schnellansicht kdnnen Sie die Maus Uber den Bildschirmrand hinaus bewegen, um die Bilder
anzuzeigen, die sich am Ende der Reihe befinden. Die Grof3e der Zeichnungs-Voransichten kdnnen Sie regeln,
indem Sie die Strg-Taste gedriickt halten und dabei das Scroll-Rad Ihrer Maus vor oder zuriick drehen.
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Abbildung 26. Schnellansicht fir Zeichnungen

Bewegen Sie den Cursor Uber eine Zeichnungsvorschau, so werden in den oberen Ecken des Bildes die
Schaltflachen ,Sichern“ und ,SchlieRen” angezeigt, die Ihnen die rasche Speicherung oder das Schliel3en jeder
— und nicht nur der aktuell ausgewéhlten — gedffneten Zeichnung erméglichen. Weitere Werkzeuge stehen in
der Steuerungsleiste der Zeichnungs-Schnellansicht zur Verfigung, die automatisch unterhalb der
Schnellansichts-Bilder angezeigt wird. Mit diesen Werkzeugen kénnen Sie die Zeichnungs-Schnellansicht
fixieren, wenn sie wahrend lhrer Arbeit im Zeichnungs-Editor geéffnet bleiben soll. Wird die Schnellansicht fur
Zeichnungen nicht mehr benétigt, lasst sie sich einfach uUber die ,SchlieRen“-Schaltflache beenden. Mithilfe der
Schaltflache ,Neu” erstellen Sie eine neue Zeichnung, die am Ende der Schnellansichts-Leiste hinzugefiigt
wird. Vorhandene Zeichnungen lassen sich einfach mithilfe der ,Offnen“-Schaltflache aufrufen.

— Schlie3en

Sichern

Zeichnungs-Schnellansicht fixieren

Neu

Offnen

Zeichnungs-Schnellansicht schlieRen
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Abbildung 27. Die Steuerungsleiste der Zeichnungs-Schnellansicht

Wenn Sie mit dem Mauszeiger Uber ein Bild der Zeichnungs-Schnellansicht fahren, werden Voransichten aller
Layouts in dieser Zeichnung, einschlieRRlich des Modellbereichs, oberhalb der Zeichnungsbilder in einer
separaten Bildleiste angezeigt. Sie kbnnen jedes Layout innerhalb jeder gedffneten Zeichnung direkt Giber die
Schnellansichtsleiste fur Zeichnungen anzeigen und aktivieren. Um eine gréRere Ansicht der Layout-Bilder zu

erhalten, fahren Sie einfach mit dem Mauszeiger liber das Vorschaubild. Das Layout-Bild wird durch

AutoCAD LT automatisch vergroRert, wahrend die Grof3e der Zeichnungs-Voransichten reduziert wird. Sobald
Sie den Mauszeiger wieder Uber ein Zeichnungsbild bewegen, werden die Zeichnungs-Schnellansichten wieder
vergréRert und die Layout-Schnellansichten verkleinert.
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Abbildung 28. Schnellansichten fur Layouts innerhalb der Schnellansicht fir Zeichnungen

QuickInfos

Die verbesserten Quickinfos in AutoCAD LT 2009 versorgen Sie nach Bedarf mit weiterfiihrenden
Informationen, sobald Sie den Cursor Uber ein Werkzeug oder eine Schaltflache bewegen. Die verbesserten
Quickinfos zeigen nun nicht mehr nur den Namen eines Werkzeugs an, sondern dartber hinaus weitere
Informationen, darunter Grafiken, aus dem Hilfesystem.
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Abbildung 29. QuickInfo-Hilfe

Neben der Verwendung von Befehlswerkzeugen kénnen Sie auch den Inhalt der Quickinfos zur Palette
.Externe Referenzen regeln: Klicken Sie dazu mit der rechten Maustaste auf den Rand der Palette ,Externe
Referenzen®, wahlen Sie die Option flr den QuickInfo-Stil und dann entweder Vorschau, Details oder beides.
Bei der Anzeige einer Vorschau kénnen Sie festlegen, ob ein kleines, mittelgroRes oder grof3es Bild angezeigt
werden soll.
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Abbildung 30. QuickInfo-Stile

Fahren Sie mit dem Mauszeiger Uber ein Objekt in der Palette ,Externe Referenzen, so erhalten Sie eine
schnelle Vorschau der Zeichnungsgeometrie sowie ausfuhrliche Informationen, auch ohne zuvor das Objekt
ausgewahlt zu haben.
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Abbildung 31. QuickInfo mit Vorschau und Details

Die Quickinfos fur Layout-Registerkarten enthalten ebenfalls Voransichten, die Ihnen helfen, rasch das
gesuchte Layout aufzufinden.

I.{chu:u:I and Beﬂage Directary 4 Shopping Directary & Banking Directory 4

Einstellungen fur ausgeblendete Meldungen

Die Funktionalitat fr Warnmeldungen wurde in AutoCAD LT 2009 Uberarbeitet. Sie ist nun einheitlicher und
ermdglicht mehr Interaktion in der gesamten Anwendung. Im Gegensatz zu friilheren Versionen von

AutoCAD LT koénnen Sie die Anzeige einzelner Warnmeldungen steuern. Wurde friher eine Warnmeldung
ausgegeben und Sie wahlten die Option, diese nicht mehr anzuzeigen — z. B. beim Schliel3en des
Befehlsfensters —, konnten Sie diese Warnmeldung nur so wiederherstellen, dass auch alle zuvor verborgenen
Meldungen wieder angezeigt wurden. Wenn Sie in AutoCAD LT 2009 jetzt eine bestimmte Option wahlen, z. B.
+Always close the Command Line Window", speichert AutoCAD LT dies in einer Liste fur ausgeblendete
Meldungen.

=,

1 Command Line - Close Window

Do you want to close the Command Line window?

To display the Command Line window again, press CTRL+9.

[] abways close the Command Line window [ fas ] [ Mo

Abbildung 32. Meldung beim SchlieRen des Befehlszeilen-Fensters

Uber eine neue Funktion auf der System-Registerkarte des Dialogfelds ,Optionen* kénnen Sie ausgeblendete
Meldungen selektiv wiederherstellen.

FE Hidden Message Settings E] @-\

Search: qQ

Check massages to show:

=[] AutocaD LT
= [] command Line
[] command Line — Close Window
=) [] Multiline Text
] Multiline T=xt - Unsaved Changes

Abbildung 33. Einstellungen fir ausgeblendete Meldungen
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Konstruktion und Zeichnungserstellung

Layer-Verwaltung

Der Layer-Eigenschaften-Manager enthélt zahlreiche produktivitdtssteigernde Erweiterungen. So wurde er
beispielsweise in ein modusunabhangiges Dialogfeld gedndert, damit er auch wahrend der Ausfiihrung anderer
Befehle angezeigt wird. lhre im Layer-Eigenschaften-Manager vorgenommenen Anderungen werden
unmittelbar in die Zeichnung Ubernommen, eine Bestétigung ist nicht erforderlich. Wenn Sie hier Einstellungen
an den Layer-Eigenschaften vornehmen, kénnen Sie wichtige Spalten, wie z. B. den Layer-Namen, fixieren, um
diese Informationen stets im Blick zu behalten. Die Kontextmenis wurden Uberarbeitet, sind jetzt klarer
strukturiert und enthalten mehr Funktionen. Sie kbnnen eine oder alle Spalten optimieren oder maximieren,
damit Inhalt, Spaltentitel oder beides nicht gekurzt dargestellt werden. AuRerdem wurden die Inhalte der
Quicklinfos fur die Spaltentitel informativer gestaltet. Fir eine Ubersichtlichere Darstellung des Layer-
Eigenschaften-Managers kdnnen Sie das Filter-Teilfenster ausblenden.

I:: Current layer: 0 js)
E(<S o Ld X v BN
<= Filters “ s, | Mame 0. Fr... |L.. | Color | Linetype | Linews... [
N EE - MapBase|_BASE s O "3 O9 CONTL. — Def.
g}! & all Used Lar||< MapBeverages|03_BEBL.. |} O T M w... CONTIL.. — Def..
(- o[ wref -2 MapBuildings|_EDIFICIOS | ) (& T3 M w... COMTL.. — Def..
E <& MapCirculation|22_CIRC... |/ & 75 B 22 CONTL.. — Def..
= - MapCirculation|23_CIRC... | W & f3 @ 30 COMTIL.. — Def..
w ~& MapCirculation|24 _CIRC... | W & 3 [ 201 CONTIL.. — Def..
2 ~& MapCirculation|27_CIRC... | W & 3 [ 150 CONTIL... — Def..
= - MapCirculation|28_CIRC... | Y (& 3 W 72 CONMTL.. — Def..
= ~» MapCirculation|29_CIRC... | Y O 3 B 132 CONTL.. — Def.
o ~> MapGrid|_QUADRICULA... | W & 73 [0 254 CONTL.. — Def..
E < MapGrid|_QUADRICULA... | Y O "5 B w... CONTL.. — Def..
L - MapHatch|_HATCH_PAL... | Y (& 3 [0 254 COMTIL.. — Def..
@ ([ > ||+ MapHatch|_HATCH_PAR...| W & 75 [ 254 CONTL.. — Def./™
= || Orwert fiter— « || ¢ >
-
= All: 47 layers displayved of 47 total layers

Abbildung 34. Layer-Eigenschaften-Manager

Das Dialogfeld ,Layer-Einstellungen* enthélt nun auch eine Funktion zum Isolieren von Layern. Dariber hinaus
konnen Anderungen an Layer-Eigenschaften fir Riickgangig/Wiederherstellen-Vorgange zusammengefasst
werden. Auf diese Funktion kdnnen Sie in der Registerkarte ,Benutzereinstellungen“ im Dialogfeld ,,Optionen*
zugreifen.

lzolate Layer Settings
Setting for layers not isolated
(%) Lock and fade
Locked Layer Fading 50%

O off Unda/Feda

In paper space viewport use Combine zoom and pan commands

Cambine layer property change

Abbildung 35. Layer-Einstellungen
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Mit DGN-Dateien arbeiten

AutoCAD LT 2009 unterstitzt den Export Ihrer AutoCAD-DWG-Dateien in das DGN-Format von Bentley
Systems MicroStation® V7 zusétzlich zum DGN-Format V8, das bereits von AutoCAD LT 2008 unterstutzt
wurde. Sie finden die neue V7-DGN-Option in der Liste ,Files of Type* (Dateityp), wenn Sie den Befehl
EXPORT oder DGNEXPORT wahlen.

%/ Export Data X
Save in: -l-'-_‘jjl.:iaptur.Launch.DemD [w] &= @ 0t Vews v Tooks v
-1 | Marme Size | Type Dal
£ — _
l_.j IC)BuildingxRefs File Folder 11
Histary MapxRefs File Folder 11,
. ICMaterials File Folder 11

ky Documents

w”

Farvorites

L

FTP

- %] B

etafile [* wnf]
Desklop Bitmap [*.brmp]
|"E\ I Block [ dwag)
.]IJIE : File narme: 48 DGEN [".dan] [ Saus ]
B WiDGH ["dan]
Buzzsaw Files of type: EBitITIE_II:I [* bmp] by i_v__' Cancel

Abbildung 36. DGN-Export

Die Sichtbarkeit der Layer angehéngter DGN-Dateien lasst sich nun tber die Option ,DGN-Layer" im
Kontextmen fir einen ausgewahlten DGN-Anhang steuern.

Fepeat XREF
Recent Input

DGN Clip...
DM Layers. ..
_TFET__,—'“ DGM Ohject Sna;k
[#5 External References...

. -
= "IT

Abbildung 37. Einstellungen fiir DGN-Layer

Ein neues DGN-Mapping-Werkzeug unterstitzt Sie beim Mapping von DGN-
Ebenen, -Linienstilen, -Linienstarken und -Farben in AutoCAD-LT-Layer, -Linienstile, -Linienstarken
und -Farben und umgekehrt. Diese DGN-Mappings lassen sich fiir eine verbesserte Kontrolle beim Import und
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Export von DGN-Dateien speichern und wiederverwenden. Uber den neuen Befehl DGNMAPPING kénnen Sie
auf Ihre Einstellungen zugreifen und den Speicherort fur die DGN-Mapping-Setups kénnen Sie auf der
Registerkarte ,Dateien” des Dialogfelds ,Optionen* festlegen.

- -,
% Modify DGN Mapping Setup: Expo
Specify property mapping For DGR Impork H OWE
Layer || Linetype || i Color
DEN DWG |

1] 0,00 mm

1 0,13 mm

10 1,40 mari

11 1.55 mr

12 1.55 mr

13 1.55 mr

14 2,00 mm

15 2,11 mm

16 2,11 mr

17 2,11 mr

15 2,11 mr

19 2,11 mr

2 0,30 mm v

Setup descripkion;
(n] 4 l [ Zancel ] [ Help

Abbildung 38. DGN-Mappings

DWFx-Unterstutzung

AutoCAD LT 2009 enthalt Unterstiitzung fir DWFX, ein DWF-basiertes Format, das kompatibel mit dem
Microsoft-Format XPS (XML Paper Specification) ist. DWFx-Dateien lassen sich problemlos auf der Windows
Vista®-Plattform austauschen und verteilen, da dieses Format vom XPS-Viewer unterstutzt wird. DWFx steht in
allen Funktionen mit DWF-Bezug zur Auswabhl, darunter Markierung, Externe Referenzen (DWFANHANG),
Publizieren und Plotten.
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Abbildung 39. DWFx-Dateiformat

Zuschneiden von Xrefs
Die Umgrenzungsrahmen zugeschnittener externer Referenzen kdnnen jetzt mit Griffen bearbeitet werden.
Hierfir muss die Systemvariable fir XCLIPFRAME auf den Wert 1 eingestellt sein, bevor Sie die
zugeschnittene Xref-Datei auswéhlen und an einem Griff ziehen. Neben den Griffen fiir die Bearbeitung der
Schnittumgrenzungen steht Ihnen jetzt auch ein neuer Griff zur Verfigung, um den Schnittbereich umzukehren
(invertieren).
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Abbildung 40. Griffe zum Zuschneiden von Xrefs
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Interaktive Anordnungsvorschau

In der Voransicht einer mithilfe des Reihe-Befehls erstellten Anordnung von Objekten kdnnen Sie jetzt panen,
zoomen und durch das Modell navigieren, bevor Sie die neue Anordnung bernehmen. Um zum Anordnungs-
Dialogfeld zuriickzukehren und weitere Anderungen vorzunehmen, klicken Sie auf eine beliebige Stelle oder
driicken Sie die Esc-Taste. Mochten Sie die neue Anordnung tUbernehmen, klicken Sie mit der rechten
Maustaste.

Suchen und Ersetzen

Die Funktion zum Suchen und Ersetzen wurde Uberarbeitet und bietet nun neben einem erweiterbaren
Dialogfeld neue Optionen. Geben Sie den Befehl SUCHEN ein, um das Dialogfeld ,Suchen und Ersetzen“ zu
6ffnen, und klicken Sie in der linken unteren Ecke auf das Symbol fir weitere Optionen, um Suchoptionen und
Textarten anzuzeigen und zu @ndern. Wird der gesuchte Text gefunden, so vergroR3ert sich automatisch die
Anzeige.

=,

% Find and Replace

Find what: Find where:
Granite w Enkire drawing b i
Replace with:
"
[ List results
@ Replace Al ] [ Find l [ Close ] [ Help
Search Cptions Text Tvpes
[ Itatch case Block attribute Yalue
[|Find whale wards anly Dimension/leader Text
[Juse wildcards Texk (MText, DText, Text)
[]5earch zrefs Table Text
Search blocks Hyperlink Description
Ignore hidden items Hyperlink,

Match diacritics {Latin based languages)

[ IMatch half{full width Forms (East Asian languages)

Abbildung 41. Suchen und Ersetzen

Visualisierung

Geografische Position

AutoCAD LT 2009 wurde mit zusatzlichen Optionen zur Definition der geografischen Position einer Zeichnung
ausgestattet. Neben den bekannten Methoden zur Bestimmung der Position (die Eingabe von Langen- und
Breitengraden oder die Auswahl aus einer Karte) konnen Sie jetzt auch Positionsdaten aus einer Datei im KML-
oder KMZ-Format oder direkt aus Google Earth™ importieren.
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= Geographic Location - Define Geographic Loca... ﬁ

How do you want to define the location for this drawing?

% Import a .kml or .kmz file

Retrieves location information from Jkml and .kmz files.

< Import the current location from Google Earth
Allows you to specify a location in Google Earth to import.

% Enter the location values
Enter the latitude, longitude, north direction, etc. in the Geographic Location
dialog.

Abbildung 42. Optionen fur geografische Positionen

Mithilfe einer neuen Systemvariablen (GEOLATLONGFORMAT) kénnen Sie das Format der Werte fur Langen-
und Breitengrad im Dialogfeld ,Geografische Position" sowie in der Koordinaten-Statusleiste im geografischen
Modus festlegen. Auch die Sichtbarkeit des Markierungssymbols fiir die geografische Position lasst sich mithilfe
der neuen Systemvariablen GEOMARKERVISIBILITY einstellen.

Navigationsrad

AutoCAD LT 2009 besitzt ein neues Werkzeug, mit dem das Navigieren auf Ihrer Zeichnung zum Kinderspiel
wird. Mit dem Befehl ,Wheel“ (Rad) wird das Navigationsrad am Cursor angezeigt, mit dem ein schneller Zugriff
auf Zoom und Pan sowie die neue Funktion ,Zurlickspulen“ méglich ist.

N e g
F = - 1
o, =
T .
-
T e,
[ ! S

—
]
1

Abbildung 43. Navigationsrad

Mithilfe des Ruckspulwerkzeugs kénnen Ansichten aus friiheren Blickwinkeln angezeigt werden, sodass
vorherige Ansichten, die erneut verwendet werden sollen, rasch wiederhergestellt werden kénnen.
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Abbildung 44. Rickspulwerkzeug

Bildreferenzen

In AutoCAD LT 2009 kdnnen Sie Bilder einer Zeichnung als extern referenzierte Dateien zuordnen. Die neue
Option ,Attach Image“ (Bild zuordnen) befindet sich in der Dropdown-Liste der Palette fir externe Referenzen.
Alternativ kdnnen Sie den neuen Befehl BILDZUORDNEN verwenden.

x
e | - E-@
[E Attach DWG..,
Attach Image... % atus Size Type A
Attach DWF. . Oper... 312KB  Current
attach DGM... loaded S4.9KB Attach
[ MapBase oaded 691KB  Attach
Y MapBeverages Loaded 79.4 KB Attach
w | [0 MapBuildings Losded 129KB  Attach £
O | [ mapcirculat., Loaded 797 KB  Aftach
2 | Y mapcrid Loaded 30.3KB  Attach
@ | [ MapHatch Loaded 673KB Aftach
‘2 ™ MapInforma... Losded 78.2KB  Aftach
O | [ MapMaiBoxes Loaded 73.0KE Attach
3 Y Mapmultiser. . Loaded 78.2KB  Affach
m | [y MapPalcos Loaded 75.0KB  Atach
£ | Fy mapPavrho... loaded 73.2KB  Atach [«
- < 1l >
Ll
o

Abbildung 45. Option , Attach Image* (Bild zuordnen)

Nach dem Zuordnen eines Bilds kénnen Sie das Bild mit dem Befehl BILDZUSCHNEIDEN in eine polygonale
oder rechteckige Form zuschneiden. Anschlie3end I&sst sich der Bildrahmen mit der Systemvariablen
BILDRAHMEN ausschalten. Uber das neue Dialogfeld ,Image Adjust” (Bild anpassen), das tiber den Befehl
BILDANPASSEN zu erreichen ist, lassen sich Helligkeit, Kontrast und Fade des Bilds steuern. Dartiber hinaus
lasst sich die Bildwirkung tiber den Befehl BILDQUALITAT regeln.
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Abbildung 46. Dialogfeld , Image Adjust” (Bild anpassen)

Nicht-rechteckige Ansichtsfenster

AutoCAD LT 2009 ermdglicht mehr Kontrolle tber die Anzeige von Layout-Ansichtsfenstern, da Sie jetzt nicht-
rechteckige Ansichtsfenster erstellen kdnnen. Uber den Befehl MANSFEN kdnnen Sie im Kontextmenii die
Option ,Polygonal“ oder ,Object* (Objekt) wéahlen.

Enter
Cancel
Cwnamic Input 4

o don dvetburaten

Fit

|
' Qi
OFF
|
' Shadeplot 1
'Z Lack 1
Chiject

Polygonal %
Festore

Lévyer

[YFY. TN

Abbildung 47. Kontextmeni MANSFEN

Mit der Option ,Polygonal“ haben Sie die Mdglichkeit, mittels mehrerer Punkte eine mehrseitige Form fur das
Ansichtsfenster festzulegen. Sie kénnen aber auch ein Ansichtsfenster von fast beliebiger Form erstellen. Dazu
nutzen Sie die Option ,Object” (Objekt) und wahlen ein vorhandenes geschlossenes Objekt, z. B. einen Spline
oder Kreis, aus.
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Abbildung 48. Beispiele fur nicht-rechteckige Ansichtsfenster

Vollstandige Unterstiitzung von Farbe und Farbbtchern

In AutoCAD LT 2009 besitzen Sie mehr Flexibilitat bei der Festlegung von Farben. Das Dialogfeld ,Select
Color” (Farbe auswahlen) wurde tGberarbeitet und enthélt jetzt neben dem schon bekannten ,Index Color*
(Indexfarbe) Registerkarten fur True Color und Farbbucher.

%/Select Color B
Index Calor True Calar | Color Books |
ng: Saturatiu:un Luminance Color model:

B B B [hsL

True Calor Stored

az RGE:

Red:

Greern:
l Blue:

Calor:
Byl ayer

[ (] H Cancel ” Help ]

Abbildung 49. Dialogfeld , Select Color* (Farbe auswéahlen)
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Felder

Mit AutoCAD LT 2009 kénnen Sie in lhren Zeichnungen Felder erstellen. Felder, die in Text, Attribute oder
Tabellen eingefligt werden kdnnen, lesen Daten aus diversen Quellen und aktualisieren sich selbst
automatisch, wenn sich diese Daten andern. Sie kénnten beispielsweise ein Feld fir das Datum und den
Dateinamen in den Titelblock einfiigen. Sie kdnnen mit Feldern auch Objekteigenschaften anzeigen lassen, wie
die Flache einer Schraffur oder den Durchmesser eines Kreises.

% Field X

Field category: Date Format: Hiniks
2l = L. M - month

: d - day
Field names: Examples: ¥ - ear
Author A~ December 3, 2007 A~ h - hour
BlockPlaceholder 12307 m - minute
Comments 2007-12-03 tE - amor pm

F-Dec-07
ate 12,3.2007
- separator
DeviceMame Dec. 3, 07 J = seEarator
DieselExpression 3 December 2007 i - separatar
Filenamea 03.12.2007
Filesize 03/12/z2007 Morith exarnple:
Formula 2007012103
Hypetlink. Z007-12-3 M -8
HyperlinkBase December 07 M - 08
Keywords Dec-07 MMM - Aug
LastSavedBy 12/3/2007 3111 PM MMMM - August
Lagin 12/3/2007 3:11:29 PM
MamedObject B1LPM
Object B11:29PM
PageSetupMarne 1511
PaperSize 15:11:29
FlotDate Monday, December 03, 2007 (Re
FlokOrientation IMonday, December 03, 2007 3:1
?!OFEcalle_ . v 12/3/2007 (Regional shart date) |+
Field expression:
“o<hAcVar CreateDate \f "Sx" =%
QK ] [ Cancel ] [ Help

Abbildung 50. Dialogfeld , Feld*

Unterstitzung fur 64-Bit-Betriebssysteme

AutoCAD LT 2009 ist als 32- und als 64-Bit-Version erhaltlich. Die 64-Bit-Version unterstiitzt 64-Bit-Windows®-
Betriebssysteme mit 64-Bit-Chipsétzen von Intel® oder AMD®. Auf einem 64-Bit-System kdnnen Sie mit
AutoCAD LT 2009 groRRere Datensétze bearbeiten.

Fazit

Mit den neuen und verbesserten Funktionen von AutoCAD LT 2009 erhalten Sie die Kombination einer
modernen Oberflache mit der Leistungsfahigkeit bei detailgenauen technischen Zeichnungen in 2D, die Sie von
AutoCAD LT erwarten. Freuen Sie sich tber mehr Produktivitét bei der Auswahl von Zeichnungen, Layouts und
Befehlen mit weniger Mausklicks. Steigern Sie Ihre Konstruktionsflexibilitdt und verringern Sie die Fehlerquote
dank der Verbesserungen an Ansichtsfenster, Layern, Farbe, Bild sowie der Unterstiitzung von Feldern.

Autodesk, AutoCAD, AutoCAD LT, DWF, DWG und SteeringWheels sind Kennzeichen oder eingetragene Marken von Autodesk, Inc. in den USA und/oder anderen
Landern. Alle anderen Marken, Produktnamen und Kennzeichen sind Eigentum der jeweiligen Inhaber. Zu den Angaben in diesem Prospekt: Nach Redaktionsschluss
dieser Schrift kénnen sich an den Produkten Anderungen ergeben haben. Autodesk iibernimmt keine Gewahrleistung fir die Richtigkeit der Angaben.
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